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Abstract

Surveying the internal structure of a cave is an
important part of any archaeological or
palaeontological investigation of a cave locality. How-
ever, using standard topographical surveying techniques
is often difficult due both to the irregular nature of the
structure and to the difficult working conditions. This
study uses a novel method based on ultrasound re-
flections to produce an accurate 3D model of Kitley
Shelter Cave, an archaeological cave in Yealmpton,
Devon. This model enables the cave system to be
visualised leading to a better understanding of the site
and its taphonomy.

Introduction

Cave surveying techniques

Caves are generally either surveyed in a to-
pological fashion recording the bearing, inclination and
length of the passages or more exhaustively using stan-
dard interior surveying techniques to record the posi-
tions of the walls of the passages [Worthington 1987,
Ellis 1988]. Neither of these options are ideal for use
in palaeontological research [Hunt et al. 1987, Grady
1994]. The first option does not allow a comprehen-
sive visual impression of the cave to be recorded, while
the latter approach is time-consuming and may en-
counter difficulties due to access problems and the
prevalence of ill-defined, curved surfaces which are
difficult to specify precisely without fixing a number of
artificial marker points to surfaces. However, with time
and care these difficulties can be overcome and there
are excellent surveys of archaeological caves - for
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example, the survey of Kentís Cavern in Devon (Proc-
tor & Smart 1989).

The automated scanning system described in
this paper can get around many of these problems. It
is reasonably quick and it produces profiles of the
passageway at known distances into the cave system.
This approach allows a full and accurate 3D recon-
struction for later visualisation.

There are a number of computer packages to
help cave surveying. These are mainly designed for
topological surveys and help with loop closure and
error distribution. Some also have 3D visualisation fea-
tures, although these are generally for displaying sur-
vey line data rather than passage reconstructions based
on sections (for a review see Wookey 1994).

Ultrasound scanning

A number of options are available for auto-
matically calculating the distance of an object from a
point [Gibson 1996]. The most accurate systems use
electromagnetic radiation (either radar or laser
sources). Laser sources are highly dependent on the
precise reflective properties of the target object and
are unsuitable when used on rough, bare rock sur-
faces. Radar is considerably better, but suitable equip-
ment is neither cheap nor easily portable. Sound waves
are a suitable alternative for range finding where exact
precision is not required [Gibson 1991a]. Ultrasound
transducers are relatively inexpensive, and usually, ul-
trasound beams reflect well off rock surfaces. The lack
of precision is due to the difficulty in obtaining a nar-
row ultrasound beam and the problem of shaping a
precisely defined sound pulse.
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Survey Site

The Kitley caves are located in Devonian lime-
stone at Western Torrs Quarry in Yealmpton, South
Devon (National Grid Reference SX 57505125). The
quarry, now abandoned, is located in the side of a
natural limestone bluff which overlooks a narrow steep-
sided valley formed by the river Yealm. An extensive
cave system, the Kitley Show Caves, is open to the
public but many more caves and fissures penetrate the
limestone on both sides of the river Yealm, including
the Kitley Shelter Cave which is the subject of the
present study.

Kitley Shelter Cave is located at a high level
within the limestone outcrop, and prior to archaeo-
logical excavation the cave was partially filled with cave
breccias, flowstones and unconsolidated cave sedi-
ments. Since 1994 an archaeological research project,
led by the University of Sheffield and the University of
Wales Lampeter, has investigated the archaeological
and palaeontological remains in Shelter Cave. During
the research excavations the locations of archaeologi-
cal finds and faunal remains have been recorded using
local reference datums consisting of bolts drilled into
the cave roof. It was realised that an accurate survey
of the accessible part of the cave was desirable in or-
der to gain a visual impression of the cave and to de-
termine the spatial relationships between finds in dif-
ferent parts of the cave system.

Materials and Methods

The basic approach used for the survey sys-
tem is a rotating ultrasound emitter mounted so that
the beam scans the walls of the cave in a vertical plane.
The system is able to calculate the distance of the wall
from the emitter at any point in this sweep and so is
able to calculate the profile of the cave in the scanning
plane. By moving the emitter through the cave system
a set of profiles is built up as a stack of slices. These
slices can then be reassembled in a CAD program to
reconstruct the 3D shape of the cave system.

Schematic diagram of the system

The ultrasonic scanner consists of an ultra-
sound emitter and receiver mounted on the spindle of

a stepper motor. The stepper motor and the ultrasound
transmitter are controlled via a laptop computer which
also reads the signal picked up by the ultrasound re-
ceiver. The emitter sends out a pulse of ultrasound
and the echo is picked up by the receiver. The time
taken for the echo to arrive depends on the distance
from the transmitter to a solid object such as the wall
of the cave. The stepper motor then rotates the trans-
mitter and receiver through 7.5° and the process is
repeated. A complete circular scan is built up in very
much the same way as radar with the computer stor-
ing the ultrasound echo at each of the 48 scan orienta-
tions and then plotting them on the screen as a radial
map. Figure 1 shows a diagram of the mechanical as-
pects of the system. Figure 2 shows a schematic of
the electronics. Full plans, including printed circuit board
designs, can be obtained from the authors.

Description of the process

The scanner produces a radial scan perpen-
dicular to the axis of the stepper motor. To produce
an accurate 3D reconstruction both the position and
orientation of the axis needs to be known. To map a
cave system, a zero point at the entrance is first de-
fined using standard surveying techniques. Then a se-
ries of secondary markers are set up at convenient
places within the cave and surveyed by measuring their
distance, bearing and inclination from each other and
from the zero point as convenient.

The scanner unit is then moved through the
cave. It is set up at convenient points at approximately
0.5m intervals and the bearing and inclination of the
spindle recorded. In this particular case, the spindle
was always held horizontal, though there is no par-
ticular requirement to do this. The position of the
spindle was defined by the distance, bearing and incli-
nation from one of the previously surveyed markers.

Once the six degrees of freedom of the centre
of the scan have been defined, the scanning process is
automatic and takes about a minute. The actual time
taken to complete a single scan depends on the num-
ber of echo traces taken for each segment (repeated
echoes are software integrated to improve the signal
to noise ratio). The scan can be displayed immedi-
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Figure 1. The design of the scanning head. An ultrasound transmitter and receiver
    are mounted on the spindle of a stepper motor. This allows a pulse of
    ultrasound to be directed radially and the echo signal recorded at 7.5°
     intervals.

Figure 2. Schematic diagram of the data capture system. The computer program
    controls the position of the stepper motor and sends out ultrasound pulses
    in known directions. The echo signal is recorded for each ultrasonic pulse
    and used to build up an image of the cave walls.
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ately on the computer screen allowing visual confir-
mation that a useful image has been obtained.

The resolution of the system is independent of
the distance to the reflecting surface and is currently
approximately a distance of 5cm with an angular reso-
lution of 10° (see Graph 1 and Figures 4 and 5). The
latter value is constrained by the beam width of the
ultrasound transducer and the former value by the dif-
ficulties in precisely defining the edge of the pulse.
Reducing the transmitter beam width will reduce both
these values as would improved software. There are,
however, constraints on size and portability of the
equipment that mean that a realistic limit to the preci-
sion of this approach would be an arc of 1° and a
distance of 1cm. The maximum measurable distance
depends on the ambient noise level and the sound re-
flection properties of the cave, but preliminary test
showed that the prototype could identify echos from
walls more than 10m away in ideal conditions.

The relationship between scans of known
distances and the distances in arbitrary
AutoCAD units after tracing. The equa-
tion of the best fit straight line through the
points is y = 4.020 x with  r2= 0.9976.
This relationship was then used to cali-
brate subsequent measurements.

Data processing/software

The software can be divided into two parts:
data capture and data analysis. The data capture soft-
ware is responsible for controlling the scanner and stor-
ing the ultrasound echo data. Echo digitisation occurs
in real time, so parts of the software had to be written
in machine code to maximise the data throughput.
Thisresults in the digitisation speed being dependent
on the actual running speed of the host computer and
therefore the device needs to be calibrated by recording
several scans at known distances from a solid object.
In this case, this was done by arranging the scanner at
known distances from the wall of a house. Graph 1
shows the results of this calibration exercise.

The data analysis stage takes the raw data files
from the data capture program and ultimately produces
an accurate 3D CAD model of the cave. This is pres-
ently a fairly time consuming process, but there is po-
tential for several of the stages to be automated.

Firstly, the radial scans are converted into a
standard rectangular coordinate based TIFF picture
file. This is then read into the graphics package Can-
vas [Canvas, Deneba Software 1993] which handles
both bitmap and object based drawing. The central
point is then marked and the outline of the cave is
drawn by hand as an overlay. A set of 48 radial lines
are used as a drawing aid. These hand drawn vectors
are then saved as a DXF (data exchange format) file
that can be read by AutoCAD [AutoCAD, AutoDesk
Inc. 1996].

In AutoCAD, the vector outline is scaled us-
ing the factor calculated from the calibration experi-
ments and then rotated and translated so that the po-
sition and orientation of the axis of the scan matches
that recorded from the cave. Each separate scan out-
line is converted to its original cave coordinates and
can be imported into a single 3D AutoCAD file.

The outlines can then be used as surface
boundaries which are spanned by surfaces to “skin”
the wire-frame structure, producing a 3D surface model
of the cave.

Graph 1:
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Figure 4. The raw output from the scanner program. The diagram should be interpreted in very much the
    same way as a radar. The distance from the centre represents the echo time, and the brightness of
    the shading represents the strength of the reflected signal. The superimposed 48 point star indicates
    the centre of the beam.

Figure 5. The raw output overlaid with a trace representing the estimated position of the wall of the cave.
                This is generally the first large reflection signal.
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Results

Plan of Shelter Cave

Figure 6 shows the plan of Kitley Shelter Cave
obtained using standard surveying techniques. The
section of the cave surveyed by ultrasound scanning is
indicated.

Sample cross-section scan

Figures 4 and 5 show how the cross-sectional
profile is built up. Figure 4 shows the raw data from
the scanner, superimposed onto a 48 point star so that
the beam centre can be clearly identified for each of
the scans. Figure 5 shows how the cave walls are iden-
tified on this “radar” picture and drawn on as an over-
lay. Note, on figure 5, the wall at the 10 oíclock posi-
tion is poorly defined, and there is some interpretation
“by eye”.

Assembled traces

Each profile is recorded along with the sur-
veyed position and direction of the stepper motor axis.
This defines the position of the centre of the scan and
the orientation. The scale information is obtained from
the calibration curve. This information is used to shift,
scale and orient the profiles in AutoCAD. Figures 6
and 7 show the correctly oriented scans. Once the
profiles are oriented, the wire frame model can be
converted into a surface model - a process known as
“skinning”. This produces a realistic looking 3D ren-
dered model of the cave system that can be viewed
from any particular orientation (figure 8), and with the
right software, can even be walked through.

Discussion

As mentioned before, accurate surveying is a
vital part of palaeontology. The ultrasound scanning
technique presented here allows accurate surveying
and visualisation to be performed in restricted spaces
relatively quickly.

Figure 6  Plan of Kitley Shelter Cave obtained
by traditional surveying means. Stipple indicates
the parts of the cave surveyed with the ultra-
sound scanner.

Figure 7. Plan view of the set of vertical profiles
correctly scaled and oriented in AutoCAD.  The
arrow shows the direction of the horizontal view in
Figures 8 and 9.
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The visual display of the surface of the cave
system (figure 8) is a useful aid in the interpretation of
the geomorphological and taphonomic processes that
may have influenced the movement and deposition of
sediments, fauna and artefacts within the cave. The 3-
D model provides information about the directions and
gradients of the segments of cave passage, the maxi-
mum volumes of sediments that can be contained within
the cave, and the locations of points of constriction
where movements of large clasts may have been ob-

structed. Given appropriate fluid dynamic modelling
software, the 3-D model could also be used to simu-
late sediment flow within the cave. In addition, at Kitley
Shelter Cave the locations of finds and sections through
the cave sediments were recorded by measuring their
coordinates along three orthogonal axes relative to
datum points fixed to the roof of the cave. These
locational data can be incorporated easily into the
AutoCAD model of the cave to allow the display of
the position of the finds within the cave system.

Figure 8.  This figure shows an elevation of the profiles veiwed from the direction
     indicated by the arrow in figure 7.  The change in altitude at locations from
     within the cave is apparent.

Figure 9.  Fully rendered 3D representation of Kitley Shelter Cave obtained by “skinning’ the
     vertical profiles.  Direction of view as in Figure 8.
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The surface of the cave wall could have been
recorded in a similar fashion to the individual finds (i.e.
manually, using measurements from datum points in
the x, y and z dimensions). However, this would have
been extremely time consuming as it would have re-
quired 144 measurements (x, y, and z displacements
for each of the 48 radial positions) for each profile of
the cave wall recorded to achieve the same density of
information as the ultrasound scan. The time required
for basic data processing and manipulation is consid-
erably higher for the scanning method, although there
would be no difference if the traditional survey had the
same amount of information as the ultrasound one.

The use of ultrasound in caves will disturb bats.
The 40kHz transmitter used is very close to the
echolocating signal of brown long-eared, Daubenton’s,
whiskered, Brandt’s and pipistrelle bats (genera
Plecotus, Myotis and Pipistrellus). However, any hu-
man activity in a cave will disturb bats and cave sur-
veying in general should not be undertaken during sen-
sitive times of the year such as the hibernation period
(personal communication K. Jones, Roehampton In-
stitute).

There are two areas where improvements
could be made in the prototype scanning system. Firstly,
the main cause of inaccuracy in ultrasonic surveying is
due to the width of the ultrasound beam. This can be
ameliorated by either using a narrower beam [Gibson
1991b], or by using an array of receivers rather than
just a single one so that different parts of the beam can
be resolved. This requires considerably more sophis-
ticated equipment, but is in principle achievable by in-
creasing the cost of the unit and by improving the data
capture hardware and software [Altes 1995]. Simi-
larly, using wideband sonar techniques can also allow
improved spatial resolution [Wehner 1987]. The sec-
ond area for improvement is the reconstruction soft-
ware. Currently, much of the processing of the scan
image needs to be done by hand and could be auto-
mated using image recognition style algorithms. Image
recognition is notoriously unreliable, but the problem
in this case is quite well circumscribed and the posi-
tion of the first large echo could be automatically de-
tected to automate the identification of the position of
the reflecting surface.

In conclusion, the results obtained from this
relatively cheap system are very encouraging as they
provide accurate 3D models of the complex geom-
etry of a cave system in a comparatively short space
of time.
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Introduction:

The purpose of this guide is to help beginning
digital cartographers lay out and draw cave maps elec-
tronically.  Many of the suggestions here are my per-
sonal preferences, including line weights and layer
names, and can be changed to meet the needs or pref-
erences of the cartographer.  The guide assumes that
the user is at least generally familiar with the Windows
operating environment, Windows-based programs,
and the basics of cave mapping and cartographer.
Some familiarity with drawing programs is helpful, but
not necessary to use this guide.  The guide will not
teach you all of the tools available in Canvas.  Use the
one-line and manuals to find tricks and shortcuts for
some of the more common tasks.

Why Digital?

Digital cartography increases the flexibility of
cave maps.  Updating and adding new passages to
digital maps is relatively easy and faster than with con-
ventional pen-and-ink maps.  Digital maps are easier
to scale for multiple purposes (wall maps vs. publica-
tion maps) and are much easier to integrate into GIS,
web sites, digital documents and other forms of elec-
tronic publishing.  Photographs and color geology can
easily be added to digital maps to present more infor-
mation than conventional maps.  In general, digital cave
maps are more dynamic and adaptable than other types
of maps.

Drawing vs. CAD Programs

There has been a great deal of debate about
what kind of programs work best for drafting cave
maps.  CAD systems (AutoCAD, IntelliCAD,
Microstation) are great for maintaining real-world co-
ordinate systems and are easily integrated into GIS.
Drawing programs (Canvas, Illustrator, CorelDraw)

contain more freehand and image editing tools.  How-
ever, the biggest advantage drawing programs have
over the CAD programs is their shorter learning curve.
Traditional cartographers can learn to use drawing
programs much faster than trying to learn the special-
ized ling and skills of technical drawing.

Getting started

Start Canvas using the start menu.  A new
drawing will automatically appear in the window.  If
you want to continue to work on an existing drawing
select Open from the File menu.  A dialog box will
appear so you can select a file.  If you make a mistake
in a drawing and want to start over, select New from
the File menu.  A selection box will appear with sev-
eral drawing options, illustration, publication, or pre-
sentation.  Select the Illustration  option for doing cave
maps.

The Menus and toolbars

The top of the work area contains three parts,
the menu bar, the toolbar, and the docking bar (Figure
1).  The menu bar is a set of pulldown menus with
commands and tools.  The Toolbar contains buttons
you can click to choose commands, tools, inks, strokes,
and styles.  To display the Toolbar:  select
Window>Palettes>Show Toolbar.  To hide the
Toolbar:  select Window>Palettes>Hide Toolbar.
The docking bar allows you to keep palettes such as
the document setup palette, and macro box “docked”
at the top of the screen, so you don’t have to go through
the pulldowns or Tool Box to get to your most-used
features.

Document set-up and layout

To set up the blank page, go to the Layout
menu and select Document Setup.  A dialog box will
appear that gives you the options for setting up the

Canvas Map Makers Guide
by Paul Burger
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drawing environment.  You can choose any standard
paper size by selecting it in the illustration size pulldown
menu.  You can also define your own map size using
the custom option in the illustration size pulldown menu
and then typing in the dimensions manually.  These
settings can be changed later without affecting your
drawings if you decide you need more or less space
later.

Suggested layers

It is best to keep different types of informa-
tion on different layers.  This helps to avoid cluttering
the screen with too much information during drawing
and it helps to create different types of maps later on.
To create, delete, or modify layers, go to the Layout
menu and select Document Layout.  The document
layout palette (Figure 2) will then appear.  Click the +
sign next to the text that says Page 1 and the list of
layers will appears.  Click on the layer name (Layer 1
is the only layer in the new drawing) and then click the
New Layer button at the bottom of the document
layout box.  To change the name and other param-
eters of a layer, double-click the layer name.  Below is
a table of layer names that I use and what they con-
tain:

Figure 1.  The Canvas work area

In general, it’s best to keep the bitmap as the bottom-
most layer since everything will be drawn over the
bitmap.  The order of the other layers is not as impor-
tant and can be customized to your needs.

Creating bitmaps

In order to create a digital cave map, you will
need an original pencil drawing of the map or passage
first.  You can either scan in the pencil version of the
map or digitize it directly from a digitizing table.  The
following procedures are for scanning and digitizing
on-screen using the mouse.

If you are dealing with a small cave that fits on
only one or two survey pages, you can just scan the
original notes into the computer.  For a longer cave, I
suggest drafting the pencil version of the map on
gridded paper first and then scanning in the pencil map.
It is possible to assemble larger cave maps using scans
of original notes, but that requires importing the line
plot into the computer and a lot of manipulation of the
notes that is currently easier by hand. It is recommended
that you draft on gridded paper (mylar, velum, etc.) so
that you can reassemble the map from the scanned
pieces.
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Each scan will result in a bitmap image to be
saved on disk.  I generally use either the TIF or JPEG
file formats since they give the best quality for the small-
est file sizes.  These bitmaps will be reassembled in
Canvas later.

Assembling bitmaps

Unless you have a map scanner, you will prob-
ably have to scan your pencil map into the computer
in smaller pieces.  If possible, try and keep the page
straight in the scanner.  This will speed up the process

of assembling the map in the computer.  Otherwise
you may have to rotate the bitmaps so that north is the
same direction on each one.

Go to the Layout menu and select Document
Layout.  The document layout palette (Figure 2) will
then appear.  Click on the layer named Bitmap to
make it the active layer.  Click on the drawing space
to make it active and then select Place from the File
menu.  A document dialog box will appear.  Choose
the format you want to input and then the first bitmap
image of your pencil drawing.  Make sure that the

Name Contains
Walls passage walls, bedrock pillars

Structural symbols representing changes in ceiling heights, slopes, pits,
domes, dropoffs, etc

Detail floor detail such as sand, mud, bedrock, formations, breakdown

Cross sections and ceiling heights ceiling height circles and passage sections

Elevations passage elevations

Stations survey station symbols and station labels

Text passage labels and other text items

Scale scale and north arrow

Bimaps the scanned and assembled bitmap of the cave or cave passage
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option to “Place on Current Layer” is checked.  An
angular cursor will appear on the screen that will allow
you to place the bitmap.  Click on the drawing and
Canvas will important the bitmap.  Repeat these steps
for every bitmap you have scanned in.

Using the gridlines on the scans, move the
bitmaps back together.  You may have to rotate the
bitmaps slightly to make them fit.  Go to the Effects
menu and select Rotate.  In the rotate dialog box, you
can type in the exact angle of rotation.  It may take
several tries to get the correct rotation.  When you
have assembled all of the bitmaps together, select them
all by dragging a box around them with the cursor.
You may have to zoom out suing the magnifying but-
ton on the toolbox to see all of the bitmaps. After they
have been all selected, go to the Object menu and
select Group.  This will make all of the bitmaps into
one object that you can move around the space.  This
will also prevent you from inadvertently disassembling
the bitmaps as you work.

Setting up the map

Try to center the assembled bitmaps on the
page.  You may have to go back and change the page
dimensions using the page set-up procedures described
above.  Leave enough room to put in passage names,
ceiling heights, elevations, etc.  You are now ready to
begin drawing the cave map.

Walls

It doe smatter what order you digitize the map
features in, but it is best to only work with one layer at
a time.  I generally do the walls first, then the structural
features, and then the floor detail.  Go the Layout
menu and select Document Layout.  The document
layout palette (Figure 2) will then appear.  Click on
the layer named Walls to make it the active layer.  On
the toolbox, make sure that the fill is set to no fill, the
line color is set to black and that the line weight is set
to 1.5.

Select the curve tool shown above and begin
tracing the walls.  Each left mouse click you make will
add a point to the line.  Double-click a point to end
the line.  If you accidentally close the line and didn’t
mean to, just double-click the line, select the curve
tool, and keep drawing.

Structural

Go to the Layout menu and select Document
Layout.  The document layout palette (Figure 2) will
then appear.  Click on the layer named Structural to
make it the active layer.  On the toolbox, make sure
that the fill is set to “no fill”, the line color is set to
black and that the line weight is 1.0.

Drawing the Cave (Plan View)

Line Weights

1.5 Walls including bedrock ceilings in the profile and cross-sections

1.0 Structural details and floors in the profile and cross-sections

0.5 Floor detail on plan, profile and cross-sections

I also use rounded corners and ends for all of the line.

Curve Tool
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For some of the structural detail (such as floor
drops, domes, pits, etc.) use the curve tool to draw
the overall shape and the line tool to make the
hatchures.  For changes in ceiling height, you can draw
a dashed line and then add the hatchures using the
line tool.

Details

Go the Layout menu and select Document
Layout.  The document layout palette (Figure 2) will
then appear.  Click on the layer named Details to
make it the active layer.  On the toolbox, make sure
that the fill is set to no fill, the line color is set to black
and that the line weight is set to 0.5.

For symbols such as breakdown and flow-
stone, use the curve tool.  For standard symbols, you
may want to use some built-in symbols, which Can-
vas calls macros.  The macros can be found on the
toolbox (Figure 3) as the symbol that looks liked
shelved books.

In order to set up the macros for the first time,
drag the symbol into the work area as shown in Fig-
ure 4.  In the lower right corner, select the arrow and
Canvas will display several options.  To load an ex-
isting set of symbols, select Append Set and Canvas
will display a file dialog box and you can select the

pallet that contains the symbols.  Canvas 5 uses a *.pal
extension and version 6 and 7 use a *.mcr extension.

The symbols appear in the macro box.  To
use them, just click on the symbol you want and then
click on the part of the map where you want it.  To
place the same symbol many times, make sure you
have “retain selected tool” selected in your Prefer-
ences under the File pulldown menu.  If “Retain se-
lected tool” is selected, every time you click the left
mouse button, the selected symbol will appear.

If you want to create your own symbol, draw
it using the drawing tools, group all of the part of the
new symbol together, and then drag it into the macro
box.  Remember, if you want to make your new sym-
bol part of the master symbol set, you will need to
click on the arrow on the lower right of the macro box
and choose “Save Set.”

Cross Sections and ceiling heights

Drawing the cross-sections is the same as
drawing other parts of the map except you use differ-
ent line weights on the same layer.  I use 1.5-point
lines for the bedrock ceiling, 1.0-point lines for con-
tinuous floor, and 0.5-point lines for the floor detail
(Figure 5).  I also add floor detail to the sections using
macros.  After I have drawn the cross-section, I group

Line Tool

Figure 3:  Macro Tool in toolbox
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all of the parts of the section together into one symbol
to make it easier to arrange the pieces in the final draw-
ing.

Use the Text tool to place the ceiling heights
on the cave map.  Then use the Circle tool to draw the
circle around the text.  If you hold down the shift key
while sizing the circle, Canvas will draw a perfect circle
and not an ellipse. Once you have the text and circle
drawn and centered on each other, group then into
one object and place where you want.

Text

Use the Text tool to place text on your cave
map.  I usually use an Arial font for text that is part of
the map, because it is easier to read than most of the
other fonts.  Be sure to include the entrance, name of
the cave and general location (state, county), the dates
of survey, the list of mappers, your name and copy-
right notice, and other details such as cave length and
depth.

Drawing the Cave (Profile View)

Use the curve tool and macros to draw the
profile.  If you are drawing profiles in the same space
as the plan view put the bedrock features (ceiling, etc)
on the Walls layer and put the other information on the
Details layer.  I sue the same pen-weighting scheme
as I do for the cross-sections.  Put any text you want
on the profile onto the Text layer.

Assembling the Final Map
Technical details

For the final map, you will need to add a north
arrow and scale bars for both the plan view and the
profile.  You will also need to create an explanation for
all of the symbols you have used on your map.  I find

it easiest to make a master explanation on a separate
drawing with all of the common cave symbols.  I then
place a copy of the explanation into my current map
and remove all of the symbols that I don’t use.

Moving things around

Once you have all of the pieces of your map
in the drawing area, you will probably want to rear-
range things to make the layout look better to win the
Medal at the annual NSS Cartographic Salon.  Mov-
ing things is fairly easy, but you have to be careful about
how you group objects to move them.  There are two
basic ways of moving things around without messing
up your map.

On the File pulldown menu, select Prefer-
ences and check the box that reads “Select Across
Visible Layers.”  With this box checked, can select
the whole plan map and then move it.  At this point,
you have to be very careful about how you grab the
selected objects with the mouse.  If you click wrong,
you will move only one piece of the map and will have
to madly scramble up the undo button.  Another way
is to group the plan (or profile) together before mov-
ing it.

First, on the plan map, select all of the items
on the Walls layer and group them together.  Repeat
this with all of the layers on your plan map.  Now
repeat this process on all of the layers of your profile
map.  Doing this will allow you to put your drawing
objects back on the right layers later.

Make sure you have “Select Across Visible
Layers” checked in your preferences.  Now you can
group all of your grouped layers together on the plan
map (or profile).  Keep in mind that when you do this,
all of the groups will be brought into the active layer.
Now select all of your grouped layers by dragging a
selection box around them.  Group these together and
now your plan map is one object that you can more
around.  Repeat the process for your profile map.  Shift
stuff around and win that medal.
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While reading the report of the Bighorn Cav-
erns Project, which remapped that Montana cave in
1985-1986, I was reminded of the mistaken respect
many cavers seem to have for transit surveys.  This is
no doubt due to the deceptive precision involving in
reading angles to, say, the nearest half-minute of arc,
which is commonly and easily done with those instru-
ments. ** I believe “transit” surveys are in fact usually
done with theodolites, but I am not sure just what
cavers mean by a “transit survey;” that is, one in which
turning angles measured with a surveying instruments
substitutes for the compass and clinometer, but that
otherwise resembles an ordinary cave survey.  Large-
scale land triangulations are another question entirely.
The fact is that a cave survey of any substantial length
will be more accurate when done with conventional
compass and tape than with fancy surveying equip-
ment.

To demonstrate that fact, I ran a simple nu-
merical experiment on a computer.  I calculated the
accumulated error in the survey of a random horizon-
tal cave with both instruments.  The cave had one thou-
sand survey stations, with each true distance selected
randomly and uniformly in the range 10 to 50 feet and
each true azimuth selected randomly and uniformly in
the range of 0 to 270 degrees.  Restricting the range
of azimuths makes the cave actually go somewhere;

qualitatively similar, but a bit less dramatic results are
gotten if the angles are distributed around the entire
circle.  To each distance measurement in the compass
survey, I added a random error between plus and mi-
nus 0.1 feet; to each distance in the transit survey, I
added a random error in the range of plus or minus
0.01 feet, assuming use of a real surveyor’s chain.  To
each compass reading I added a random error be-
tween plus and minus 0.5 degrees; to each transit angle
I added a random error between plus and minus 0.5
minutes, sixty times smaller than the assumed com-
pass error.  The total survey error at each hundredth
station was calculated.  I ran one hundred such ex-
periments and averaged the results.  (Aren’t comput-
ers nice?)  The result is tabulated below.

The slight irregularity reflects the fact that ran-
dom walks are seldom “typical,” that is, while their
average properties can be calculated, the spread is
quite large.  More than 100 trials would have smoothed
the curves more.  The results, which are also shown in
the accompanying graphs, are nevertheless clear and
perhaps rather surprising.  Despite 10 times better dis-
tance measurements and sixty times better angle mea-
surements, the transit does little better after only a
couple of hundred stations, and actually is worse, by
an accelerating margin, after five hundred.  What is
going on?

The Transit Survey Myth
by Bill Mixon

Reprinted from Compass & Tape
Volume 5, Number 1

Number of Stations          Average Error in Feet
Compass Transit

100 1.6  0.4
200 2.3  1.0
300 2.7  1.7
400 3.1  2.7
500 3.2  3.7
600 3.6  4.9
700 4.0  6.1
800 4.1  7.4
900 4.4  9.0
1000 4.7 10.7
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The answer lies in the way angles are actually
obtained in the transit survey.  After somehow deter-
mining the direction from the first station to the second
(more on that later), the instrument is placed at the
second station and the difference in the directions to
the first and third stations is read, which allows calcu-
lating the actual direction to the third station.  Then the
difference in directions from the third station to the
second and fourth is read, from which is derived the
azimuth between the third and fourth, and so on.  An
error in any direction measurement influences all sub-
sequent azimuth calculations, since every azimuth is
calculated as, essentially, the sum of all preceding angle
readings whereas in a compass survey, the azimuth
errors, though larger, each affect only one left of the
survey.  It is the accumulation of azimuth errors over
many stations that accounts for the fact that transit sur-
veys become less accurate as they proceed, whereas
the random compass errors tend to cancel out to some
extent.  So a compass survey becomes more accu-
rate, percentage-wise, the longer it gets.

Of course, my simulation doesn’t really re-
flect the true accuracy of the typical cave survey.
Compass surveys more often quote errors, where clo-
sures are available, of around 0.5 percent, not less
than one-tenth of that.  This is presumably due to blun-
ders – reading or recording errors, misunderstandings
among party members about station locations, and the
like – and non-random errors that result from, for in-
stance, using uncalibrated compasses or stretched
tapes.  Also, I am assuming that there is no station-
position error that is the instrument is always placed
exactly at the point just sighted to.  In the case of com-
pass surveys, random station-position errors behave
like compass or distance errors; they tend to partially

cancel.  In a transit survey, station position errors con-
tribute an extra component to the angle errors, which
accumulate.  Whether transit surveys come closer to
even their theoretical accuracy is doubtful.  I find it
hard to believe that station-location errors of under
one-hundredth of a foot are attained under cave con-
ditions, for instance, and of course a single angle blun-
der has drastic results.

Since any direction error in a transit survey
affects every subsequent shot, the direction of the first
shot is very important.  In a compass survey, the first
shot is just another shot.  But if a compass is used to
give the direction of the first shot in a transit survey,
then the absolute positions of distant points in the sur-
vey will be seriously affected.  For instance, a quar-
ter-degree error in the first direction would along re-
sult in an error of 23 feet in the position of a point one
mile away.  This will not affect closures within the cave,
of course, which can be good, in that promising loca-
tions for connections and such will not be spoiled, and
can be bad in that a false impression of overall accu-
racy will be obtained from in-cave closures.  I wonder
how many transit surveyors actually make sure their
first angle is as good as all of the others, which would
require a carefully timed sighting on the North Star.

I doubt if very many cave surveyors have se-
riously considered making a transit survey five hun-
dred stations long.  They needn’t feel guilty about their
laziness.

**(Editor’s Note:  The distinction between transit and theodolite
seems to be rather vague in the surveying and civil engineering
literature.  Transit often refers to a telescope-sighted compass, with
graduations read by vernier.  Theodolites tend not to have com-
passes, have either graduations read with microscopes or digital
readouts and are used as Bill describes – John Ganter, editor, Com-
pass & Tape, Vol. 5, No. 1, 1987)
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plot by Toporobot

Profile of  Kijahe Xontjoa
 Cerro Rabon, Mexico


